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Preface 

 
Microsoft Excel is the world's most used business intelligence tool. Its 
knowledge is even compulsory for an MBA degree and the business 
world depends greatly on it.   
 
This book is aimed at making you very good in Microsoft Excel for 
business data analysis, teaching you with companion videos and 
practice files that can be accessed at www.urbizedge.com/about  
(bottom of the  page). It's intended for Sales Managers, Financial 
Analysts, Business Analysts, Data Analysts, MIS Analysts, HR 
Executives and frequent Excel users.  
 
It is written by Michael Olafusi a three time Microsoft Excel MVP 
(most valuable professional) and a ful l-time Microsoft Excel 
consultant. He is the founder of UrBizEdge, a business data analysis 
and Microsoft Excel consulting firm. He has trained hundreds of 
business professionals on Microsoft Excel and has used the experience 
gained from interacting with t hem both during such trainings and 
while consulting for companies to write this excellent guide for the 
busy professional who needs the improved work productivity 
Microsoft Excel provides.  
 
This book is constantly being updated to cover the new features in  
new versions of Excel and if you purchase the kindle version you can 
always re-download the updated copy. Just check the book listing 
page (http://www.amazon.com/gp/product/B01255TQ84)  for 
updates and re-download if a newer version has been published. All 
at no cost to you. It is the best way to give you value for your money 
without forcing you to buy different editions of the same book. If you 
feel any part of this book can be better improved or expanded, 
please send an email to mike@urbizedge.com   

http://www.urbizedge.com/about
http://www.amazon.com/gp/product/B01255TQ84
mailto:mike@urbizedge.com
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Microsoft Excel: Itõs more powerful 
and easier to use than you think!  

 

 

 

 

 
Weõve got Home menu, Insert menu, Page Layout menu, Formulas 
menu, Data menu, Review menu and View menu. Each of these 
menus will be discussed in practical terms.  
 
The other menus ñ Developer menu, Load Test Menu and Power 
Query menu ñ are not displayed by default. I enabled them as I do a 
lot of programming and other advanced stuff in Excel which I need 
them for.  
 

Home Menu 

 
The home menu is Excelõs most used menu. It has very 
straightfo rward sub-menus. 
 



 

 
 

6 

 
 
Clipboard: Allows you to copy, cut and paste in Excel  
Font: Allows you to set font size, color, background color (fill) & turn 
on bold or italics or underline.  
Alignment: Allows you to set the position of whatever youõve typed 
(or copied) into Excel. It also allows you to set how itõs written: 
horizontal, vertical or slanting.  
Number: Allows you to set how a number is shown in Excel: regular 
number, currency, scientific, percentage, fractioné  
Styles: Allows you to set the format of an Excel cell based on the 
data it holds (conditional formatting). It also allows you to convert a 
selection of cells to table, and to set quick formats for a cell.  
Cells: Allows you to insert new cells, delete cells and change cell 
format.  
Editing: It houses the very useful Sort and filter tools. And also Find 
& Select, Find & Replace. Thereõs also AutoSum which helps you sum 
all numbers in a selection.  
 
 

Insert Menu  

 
The Insert menu houses some of Excelõs best tools. 
 

 
 
Tables: Allows you to insert PivotTab le, PivotChart and Table. 
Inserting a table in Excel allows for quick formatting, and better 
formulas (via named ranges). PivotTable and PivotChart will be 
discussed later. 
Illustrations: Allows you to insert images and shapes. 
Charts: Allows you to insert  charts, which will be specially discussed 
later.  
Tours:  Houses Map which takes you straight to Power Map. Power 
Map is part of Microsoftõs new Power BI. It enables you make geo-
maps and create amazing data visualization tours.  
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Reports:  Lets you access Power View, another Power BI tool. Power 
View allows to create a data model, loading up many different 
databases and creating analysis that cuts across all the databases, 
allowing you to see insights that are beyond a single database.  
Sparklines: Allows you to insert charts that fit into one Excel cell. 
They make some reports beautiful and easy to read.  
Filter: Allows you to filter out field values you are not interested in.  
Links: Allows you point a cell content to a website or an email 
address. 
Text: Allows you to insert texts and objects (pretty much anything, 
including a PDF document) 
Symbols: Allows you to type out equations and special symbols.  
 
 

Page Layout Menu  

 
The Page Layout menu does just that: setting up your Excel 
documentõs page look and for printing.  
 

 
 
Themes: Itõs not often used; it sets the look of the Excel window 
itself.  
Page Setup: It allows you to set how the page comes out when 
printed. Most used are the Orientation (to set as Portrait or 
Landscape) and Print Area (to select on the cell s you want to print).  
Scale to Fit: It allows you to set how much is printed per page. Most 
frequent use is to force Excel to print on one page, or fit all the 
fields (columns) on one page width.  
Sheet Options: You wouldnõt want to change the default. It allows 
you set whether Excel gridlines be printed or not, and headings too. 
Default is no/off (unticked).  
Arrange: It lets you rearrange overlapping objects (shapes, images, 
textboxesé). Or align them. 
 
 

Formulas Menu  

 
The Formulas menu gives you access to Excelõs built-in formulas.  
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Function Library: It has the formulas grouped by category. Once you 
have an idea of what you want done, it helps you locate the formula 
to use. Itõs good to look through it once in a while to have an idea of 
the out -of-the-box analysis Excel can do. 
Defined Names: Lets you name a cell or selection of cells. Can be 
very useful when analyzing a big database or building a model.  
Formula Auditing: Allows you to check for errors in your formulas, 
trace formula cells and see how yo ur final result is being calculated.  
Calculation: Allows you to set when the formulas in your Excel sheet 
are calculated: automatic (whenever a cell value changes) or manual 
(at first entry and when you force them to be recalculated).  
 

Data Menu 

 
The Data menu allows you to work with external data and do basic 
data formatting.  
 

 
 
Get External Data: It allows you to import or link to an external data 
file (non -Excel file). Youõll use it whenever you have a data in text 
file and need it worked on in Excel.  
Connections: Allows you to make changes to the connections/links to 
an external data file. Or force a refresh of the connections to capture 
changes made in the external data file since last connection.  
Sort & Filter: Allows you to sort data and do some filt ering too. Filter 
allows you to specify values to display.  
Data Tools: Allows you do very basic data analysis. Especially 
removing duplicate entries, and splitting one field into several (text -
to-columns). Example is splitting full name into first name and  last 
name. 
Outline: Allows you to group (and hide) several rows. Useful for large 
data reports with few categories; helps to group categories.  
Analysis: This is only visible after you enable Data Analysis add -in or 
Solver add-in. It allows you access a la rge collection of statistical 
analysis tools and modeling. 
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Review Menu  

 
The Review menu is for spell checks, commenting and setting access 
restrictions.  
 

 
 
Proofing: Allows you to carry out spell checks and word meaning 
checks. 
Language: Allows you to tr anslate the Excel file content from one 
language to another.  
Comments: Allows you to include comments in an Excel sheet, view 
all comments at once or delete comments.  
Changes: Allows you to set access restrictions and track changes to 
the Excel file. Also allows you to share the file.  
 

View Menu  

 
The View menu allows you to change the window layout of the Excel 
document. It doesnõt change anything in the actual document, just 
the way itõs displayed. 
 

 
 
Workbook views: Allows you to set how the workbook (Ex cel file) is 
displayed. 
Show: Controls what non-printing details are shown: Gridlines, 
Headings, Formula bar and Ruler. The one youõll be interested most 
in is Gridlines. If you want your Excel sheet to look more like a Word 
file, untick the Gridlines. Tha tõs whatõs done to every Excel sheet 
you see that has no Gridlines.  
Zoom: Does what it says: sets zoom. 
Window: Allows you to freeze headers so when you scroll they will 
never be out of view. And also allows you to split the Excel sheet 
display, so you can compare two different parts of the sheet.  



 

 
 

10 

Macros: Allows you to see the macros programmed in the Excel file 
(if thereõs any macro in it). Shows only when the developer menu is 
enabled.  
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How Excel Handles What You Type  

 
In Excel, you type into small rectang ular boxes called cells. I would 
be referring to everything you type or copy into Excel cells as Data.  
 
Every cell has an address, because each cell is an intersection of a 
row and a column. The cell selected in the image below, is addressed 
as cell A1. It is the intersection of column A and row 1. A collection 
of millions of these cells make an Excel sheet. And an Excel file (also 
referred to as Excel workbook) is a collection of one or more Excel 
sheets. 
 

 
 
Sometimes, what you type into a cell takes mor e space than the cell 
has. Donõt worry, just expand the column width by dragging the right 
border of the column header.  
 
Like this:  
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Different Data Types in Excel  

 
Excel recognizes 4 different data types: Text, Number, Boolean & 
Formula. Anything you t ype into Excel will fall under one of these.  
 
Text: Whenever you type alphabets, or a mix of alphabets and 
numbers into Excel (without proceeding with =), everything is 
recognized as text. By default, Excel aligns text to the left of the 
cell.  
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Number:  If all you type into a cell are digits, they are recognized as 
Number by Excel. By default, Excel aligns number to the right.  
 

 
 
Boolean: FALSE and TRUE are Boolean entries. Youõll hardly use 
them. They are used for setting up complex formulas. By defaul t, 
whenever you type false or true in a cell, Excel will put it in upper 
case and align it to the center.  
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Formula: Once you begin a cell entry with =, Excel treats everything 
you type after as a formula.  
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As a recap, see the image below.  
 

 
 
 
The practical importance of this is that if you receive a sales report 
in Excel and the numbers are aligned to left instead of right you 
should be concerned. There are three reasons this can happen and 
two of those reasons will cause some of your mathematical formulas 
to not work correctly. You wouldnõt want to do an incorrect analysis, 
so itõs best to check why the numbers are aligned to the left and not 
to the right as expected.  
 

1. It could be that the author forced the numbers to align to the 
left. To find out  if thatõs the reason, check the alignment under 
Home menu. 
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2. It could be that the author forced the number to be treated 
as text by setting the cell format to text  
 

 
 

3. It could be that the author preceded the number with a 
single apostrophe (õ) before typing the number. This is a trick savvy 
users use to force Excel to keep the zeros at the beginning of your 
phone number or bank account number. Unfortunately, it forces 
Excel to treat the cell entry as a text and align it to the left.  
 

 
 
Out of these thr ee ways of making a number show as aligned to the 
left, only the first one leaves the number intact. The other ways 
transform the number to text and will give you issues when you 
include them in calculations that normally would work on numbers.  
 
Now you have an idea of how useful an understanding of the default 
ways Excel treat the different data types can be in your day to day 
use of Excel. 
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Data Consistency, starting with the end in 
view  

Excel is different from every other Microsoft Office program you use . 
Most of the documents, reports and analysis you do with Excel will be 
used some day in the future for another report or analysis.  
 
To become an expert in Excel, you have to always work with the end 
in mind. You have to create your Excel documents in such  a way that 
you can easily use them for some bigger reports in the future. And 
there are some general rules I'll recommend you work with to achieve 
this.  
 
1. Always use a compact table structure for entering you core data in 
Excel. This means using the minimum number of rows and minimum 
number of columns. Example of a compact table and non -compact 
table is shown below:  
 

 
 
Same table but not compact, shown below.  
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In the non-compact table example, you can delete rows 37 and 38 
without deleting any data i n the table.  
 
2. Use descriptive names for your column headers and row headers.  
Be as descriptive as possible in naming the fields in your table, make 
it easy for anyone who will view your table to understand the 
information it convenes.  
 
Below is a table with field names that are descriptive enough for 
anyone to understand the information the table convenes.  
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Below is a table that has headers that are not descriptive enough. Itõs 
hard to figure out the specific information in the table. Is it a table 
of revenue or expense? Are the companies clients or suppliers? What 
year do the months represent ñ January 2014 or January 2015? 
Whomever you send this report to will call you back for a detailed 
explanation of what you intended to report.  
 

 
 
3. Name your Excel sheets 
Donõt just go ahead with the default names ñ Sheet1, Sheet2, é ñ 
rename the sheets to reflect the contents of the sheet. This makes 
your work better organized and future use more convenient.  
 

 
 
To rename a sheet, right click on the sheet name ( the default names 
are Sheet1, Sheet2, é) and select rename. And as you see above, you 
can change the color from the default too.  
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4. Also use descriptive names when renaming the Excel sheets. 
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5. Avoid putting too many tables in one Excel sheet.  Best to keep just 
related tables in the same sheet if you must put more than one table 
in the sheet. It makes naming the sheet easy and straightforward.  
 
6. Use same naming conventions and table structure across all similar 
Excel files, especially weekly,  monthly and yearly reports of the same 
data.  
 
7.  Donõt use CAPS excessively. It makes your reports very 
unprofessional.  
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Building Datasheets that can easily scale  

 
Occasionally, you will have to work on a table whose data grows 
continually. We can refer to such tables as datatables. All tables hold 
data and can technically be referred to as a datatable, but in this 
book we will refer to all tables as just tables and limit the term 
datatable to only tables that grow perpetually.  
 
An example of such a tabl e is an Employee Record table. As long as 
the company exists the table will keep growing and even if the 
company aims to not have over a 100 employees, there will always be 
old employees leaving and new ones taken to replace them. And they 
all have to be c aptured in the employee record table, no employeeõs 
record is deleted when he leaves, thereõs only a field added to 
capture his resignation.  
 
There are some peculiar ways of treating a datatable.  
 
1. Have only one datatable on a sheet. Since a datatable is  a table 
you expect to grow over time, having only one on a sheet lets you 
have access to all the rows and the columns in the Excel sheet.  
 

 
 

2. Start a datatable as close to cell A1 as possible. Again, this is to 
afford you the maximum space in the sheet  for your growing table.  
 
3. Avoid meaningless gaps in the datatable. Make it as compact as 
possible. 
 
4. Arrange the fields such that the most important or basic fields 
come first. For example, in an Employee record table, name should 
come before contact address. 
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5. Have a field for every meaningful chunk of data. It is better to 
have separate fields for first name and last name than have one field 
hold both.  
 
6. Avoid merging cells in a datatable. It is better to repeat cell 
entries than merge the cells.  Merged cells arenõt formula friendly. 
 
And as a bonus, avoid hiding rows and columns in the datatable. This 
will save you a lot of future headaches.  
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Sorting 

Sorting is one of the most frequent task we do in Excel. Sorting lets 
you re-arrange data in alph abetical order, lowest to highest, highest 
to lowest, and even by cell color.  
 
We are used to having data arranged in a particular order ñ A to Z, 
January to December, 1 to 10, and so on.  
 
Below is an example of a table that has its records haphazardly 
arranged. The states are not arranged alphabetically and the months 
are not in the natural order.  
 

 
 
First, letõs have the data sorted by State alphabetically  
 
Below are the recommended steps to sorting a table. Select the 
table, go to the Home menu and cli ck on Sort & Filter.  
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The sorting dialog box comes up.  
 

 
 
This dialog box allows you to add more than the default one level of 
sorting.  
 
Select òStateó in the Sort by box and A to Z in the Order box. 
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The result is shown below.  
 

 
 
You can add an extra level of sorting in the sorting dialog box. This 
would be useful in sorting tables like a national population census 
table. You might want to sort first by state (from Abia to Zamfara) 
and then an extra level of sorting by Local Government Areas. So 
youõll have a setting similar to the one below 
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Next is to sort the months in the natural order we are used to ñ Jan 
to Dec. This will require a type of sorting called òLeft to Rightó as 
against the one we just did, called òTop to Bottomó. 
 
So to get th is done, we select the table starting from the first month 
to the last month. We will leave the state field out because we want 
it to remain in the position it is.  
 

 
 
Then select the row the months are on (Row 2) and set the order to 
Oldest to Newest .  
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Below is the result.  
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Filtering  

 
Filter is one of the Excel power userõs most used tool. It allows you 
selectively choose what you want to view in a table and hide the 
rest.  
 
It is very easy to access and can be accessed from three different 
places in Excel. 
 
By right clicking and selecting Filter.  
 

 
 
From the Home menu, clicking on Sort & Filter at the right.  
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From the Data menu.  
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Once youõve turned on the Filter tool by clicking on it, you will see a 
dropdown box beside the headers of the tabl e. 
 

 
 
Clicking on the dropdown box shows you all the unique items in that 
field and you can select the ones you want to view (hiding the rest). 
By default, all items are selected so you will have to unselect the 
ones you donõt want to see. 
 
In the screenshot below, all the pizza items were unselected except 
the BBQ Chicken (meaning only BBQ Chicken was selected). 
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Notice the blue row numbers, it is Excelõs way of visually hinting you 
that some rows have been hidden as they did not contain the items 
we want to view.  
 
Filtering is that simple and straight forward.  
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Advanced Filtering  

Every time you apply filter to a dataset in Excel and then copy out 
the filtered data, you could have saved yourself time and some 
mouse-strokes by using advanced filter. And despite the name, 
advanced filter, it is surprisingly easy to use.  

As an example, I have the fictitious sales record for Dhormino's Pizza 
for June 5, 2016. They sell 16 Pizza types: Meatzaa,  Extravaganza 
, BBQ Chicken, Hot Veggie, BBQ Philly Steak, Chicken Feast, Chicken 
Suya, Chicken Legend, Beef Suya, Margarita,  Italiano,  Pepperoni 
Suya, Veggie Supreme, Hot Pepperoni Feast, Chicken 
Bali and Pepperoni Feast. 
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They got a new country manager this March, and one of his strategies 
is to have four brand manag ers owning 4 different baskets of the 
pizza types, like the FMCG companies do. Two of those managers are 
Michael and Mary. They are to ensure that the brands (pizza types) 
they own are performing well. They are given the latitude and 
resources to promote t hem using whatever promotional mix they 
want.   

As the company's main business data analyst, you pull out daily sales 
records and extract the ones for each brand manager. With advanced 
filter, it will be a piece of cake. You might even hook it to a recorded  
macro and at a click of button all is done.  

Continuing with the example, let's see how to extract for Michael and 
Mary. 

 
 

Step 1 is to write out the pizza types Michael and Mary manage, 
separately. And to help advanced filter know where to look for those  
pizza names, give them a header that matches that in the sales 
table. See the screenshot above for what I mean.  
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Step 2 is to go to Michael's sheet (another Excel sheet where you 
want to put Michael's). Launch advanced filter from there. It is under 
Data menu, about the middle of the menu tools.  

 
 

Set it to "Copy to another location"  
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Provide the sales data range as the "list range", and Michael's pizza 
types with the header as the "Criteria range".  
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Finally, for the "Copy to", go to Michael's sheet and  select where the 
result should be displayed. In this example, I select cell A1.  
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And voila! We get the results.  
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Very easy and cool. 
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And there is more to advanced filter. How about if we have a more 
detailed sales transaction data that captures sales value for each 
sales transaction, and we would like to extract sales transactions that 
generated more that 15,000 naira. That too is very easy with 
advanced filter.  

Just follow me. Below is the snapshot of the detailed sales 
transaction data.  

 
 

We have specified that we want greater than 15,000 naira 
transactions only.  

The steps are just like previous ones. Launch the advanced filter and 
provide both the "List range" and "Criteria range"  
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Specify where the results should be displayed.  
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And voila, again! It's done!  



 

 
 

44 

 
 

Now you should be an expert, like me, at using advanced filter.   
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Excel Errors 

If you've used Excel consistently at work for a few months, you will 
be familiar with some errors Excel displays when it can't get you the 
answer you want. Ofte ntimes, we don't give some thoughts to these 
errors but the truth is they are not random or meaningless, they are 
trying to tell you something important.  

Today, I will be sharing with you how to interpret those errors and 
uncover the gem in them. How to re ad the message they are trying to 
pass across to you. 

There are eight error types in Excel:  

1.  #VALUE! 

2.  #DIV/0! 

3.  #N/A 

4.  ######## 

5.  #NAME? 

6.  #REF! 

7.  #NUM! 

8.  #NULL! 

#VALUE! Error  

You get #VALUE! error when you do a calculation in Excel that doesn't 
make sense. Like Michael + 2. What is Michael + 2? Is Michael a 
number? What kind of answer are you expecting? Can you try it on 
your CASIO calculator?  
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To be blunt, #VALUE! is Excel's way of saying someone is stupid. 
Someone has typed in a calculation that makes absolutely no sense.  

#DIV/0! Error  

As the name implies, division by zero, #DIV/0! is the error you get 
when you do any formula that divides a number by zero.  
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Now, I have a trick question for you: what error do you think Excel 
will give you when you divide Michael by  zero? #VALUE! or #DIV/0!? 

#N/A Error  

This is the error you get when you do a lookup function (VLOOKUP, 
LOOKUP, MATCH etc.) and Excel can't find what you are looking for. 
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####### Error  

You get this error for two reasons. The first and more common one is  
when there is not enough space in your Excel cell to display a 
numeric (number) value. Excel doesn't want you to take 1,000,000 as 
1,000 because space was only enough to show 1,000. So it puts in 
####### in the entire cell and force you to expand/widen th e cell to 
see the entire content.  
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The second and less common one is when you do a calculation on 
date and the resulting date answer is too large or too small a value to 
be shown as a valid date in Excel. Here's what I mean. In Excel you 
can do 26-Aug-16 + 1 and you will get 27 -Aug-16 (the next date).  

But when you try 26 -Aug-16 + 999999999 you get ######## and no 
amount of expanding the cell will make the error go away. You are 
trying to calculate a post -apocalyptic date.  
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#NAME? Error 

This is the error you get when you type a formula name that doesn't 
exist in Excel. Maybe you wanted to type SUM but mistakenly typed 
SUN. Well, Excel doesn't know about the solar system so t will tell 
you that it doesn't recognize that formula name.  
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#REF! Error  

This is a very popular and troublesome error. It happens when you 
have a formula that picks value from a different sheet or different 
file and somehow the file or sheet becomes inaccessible (or deleted). 
When Excel tries to recalculate the formula, it give s you that #REF! 
error because it can't access one of the reference file/sheet.  
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55 

 

 
 

A funny case that causes it is when you drag a formula that depends 
on a cell above it too way up that it messes with Excel's cell 
reference system.  
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#NUM! Error  

This is the error you get when you do a calculation that is too large or 
too small for Excel to handle. An example is 999 raised to the power 
of 99999 
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#NULL! Error  

This is a very uncommon error. We are all familiar with the 
multiplication, addition, subtra ction, division etc. operations. There 
is one not very commonly known -- the intersect operator. And it is 
simply a space. It gets you the intersect value of two different 
ranges. 
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So what happens when you select ranges that do not intersect? You 
get #NULL! error.  
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And those are the errors in Excel and their interpretation. Now you 
know what they are telling you anytime you come across them.  
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Data Cleaning 

 
A lot of times the data you are given to work on in Excel is not in a 
format usable for you and need some cleaning before you can go 
ahead with the analysis you intended doing on it. In most cases you 
have to manually clean the data and fix whatever issues it has one by 
one before progressing with the original analysis you intended to do 
on the data.  
 
Fortunately, Excel has some nifty tools to help you automate some of 
this data cleaning process. The most common ones are,  

ɻ Removing duplicates, and 

ɻ Text to Columns 
Then weõll cover a special tool that can help you do a quick 
categorization of your da ta: Subtotal. Finally weõll cover Data 
Validation, an ingenious tool for reducing data entry errors in your 
Excel files.  
 

Removing Duplicates.  

 
Occasionally, you will have a table and youõll want to remove 
duplicate entries. If it were a sales transaction table, you might want 
to remove the duplicate sales entries. In the example below, it is a 
table of items (Pizzas) and we want to remove the duplicate entries 
leaving only unique entries.  
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As illustrated above, you select the entire records first and th en go to 
Data menu, click on Remove Duplicates. You will get a confirmatory 
dialog box. Click on OK. 
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Youõll see a result showing the number of duplicate values that were 
found and the number of unique values found. Basically, what 
Remove Duplicates does is it leaves one record of each item and 
removes all the extra record for that item that it finds.  
 

 
 
When you select a table with more than one field entry, the Remove 
Duplicates remove only the entries that have same value in all the 
fields as a previous entry except you specify which fields to exclude 
in the search for duplicates.  
 
In the screenshot below, we excluded Car Sales from the fields to 
include in the search for duplicates. So rows that have the same 
entries in all the other fields will be deleted except one.  
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Text to Columns  

 
There will be times you will have data you would prefer split across 
multiple columns squeezed into one column. This happens a lot when 
you copy data from an external source into Excel or you open an 
exported data from other business software like CRMs and ERPs. 
 
Excelõs Text to Columns tool is the magic tool for splitting such data 
entries into multiple columns provided there is a recognizable 
character separating each field or they have fixed lengths per field. 
Below is a simple example for splitting a full name in one column to 
first Name column and last Name field column.  
 



 

65 

 

 
 
Delimited is the option to specify that there is a recognizable 
character separating each field. In this example, there is a space 
separating every first name from the last name.  
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Notice how Excel shows a line between the first names and the last 
names once you select the appropriate delimiter (space, in this 
case). Click on Next and Finish. 
 

 
 
Below is the result. Just as desired.  
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Subtotal  

 
Subtotal is a secret tool for doing a quick analysis of a table in Excel. 
It breaks the data down by categories and creates grouping that 
shows you different levels of details.  
 
It is also very easy to use.  
 
Below is an example where weõll use it. 
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It is a market research data table showing the different car make sold 
in three different auto dealerships.  
 
We can apply a subtotal to this to see some interesting analysis.  
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Select the table, go to Data menu and click on Subtotal. In the dialog 
box that comes up, in the òAdd subtotal toó section tick all the fields 
that have numeric values (except you donõt want to see a numeric 
analysis of them).  
 
Once you click on OK, you get a result that looks like the following ñ 
 

 
 
Level 1: 
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Level 2: 
 

 
 
Level 3: 
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And the best part is that you can remove the subtotal and have your 
original table data back just as it was before. To remove is as easy as 
clicking the Subtotal again and clicking on Remove All.  
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See the result below. All the level 1, 2 &  3 groupings gone. 
 

 
 
 

Data Validation  

 
This is another secret but powerful tool in Excel. It helps you put in 
place some error check mechanism and can be used by a skilled Excel 
user to make powerful Excel dashboards.  
 
Letõs see some of the common uses of it.  
 
The table below is an Employee records table. In it we want to force 
people to enter just departments specified at the left of the table. In 
fact, we want them to have the easy option of seeing a pre -
populated dropdown list and pick a department fro m the list options.  
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We select the cells we want to give this functionality, go to Data 
menu and click on Data Validation (sometimes twice).  
 

 
 
Youõll see that there are many options to pick between. 
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1.  Any Value.  This is the default and it is same as no t having 
any data validation. The user can enter any value into the cell.  

2.  Whole Number.  This forces the user to enter only numeric 
values that are whole numbers. If the user enters a text or decimal 
entry heõll get an error. This might be applicable in an invoice sheet, 
for the cells that hold the order quantity if you donõt sell fraction of 
your products.  

3.  Decimal.  This forces the user to enter a whole number or 
decimal entry. A whole number is same as a decimal with zeros after 
the decimal point. This migh t be great in a financial model sheet, to 
hold values of growth assumption, exchange rates and risk premiums.  

4.  List.  This is the one we are most interested in. It enables us 
to limit the cell entries to a list of options. We will use this in the 
example under review.  

5.  Date.  This forces the user to enter a valid date entry.  

6.  Time.  This forces the user to enter a valid time entry.  

7.  Text Length.  This allows the user to enter any value as long 
as the character length is not more than the specified value here. It 
is good for fields that hold phone numbers, maybe you want to limit 
the entry to the +2348123456789 14 characters long entry format.  

8.  Custom.  Just as the name specifies, you want to limit the 
cell entry to something less conventional and not covered by the 
other options.  
 
In this example we are going to use the List option. So letõs select it. 
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Once you click the icon on the far right corner of the Source box, 
select entries to limit the users to. In this case we have typed out the 
list options in cells G2 :G6, holding the different departments.  
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And itõs done. 
 
The user is forced to choose between the options in the list. He even 
sees a dropdown arrow that expands to a dropdown lists the moment 
he tries to fill the cell.  
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And that is how Data Vali dation works. When used creatively it can 
save you from the stress of making corrections to forms people filled 
and can be used in conjunction with formulas like VLOOKUP to make 
a dynamic report and dashboards.  



 

 
 

78 

Data Formatting  

 
There are some quick tips i n Excel that would turn a bland looking 
data into a nice looking one. One of the best tip is to apply a table 
formatting to the data.  
 
An example, is taking a table like the one below and turning it in a 
well formatted one.  
 

 
 
Select the data and go to Ho me menu, Format as Table. Choose a 
color theme.  
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If you want to email the Excel file to a colleague, you can copy the 
table and paste in Outlook and youõll have the beautiful looking table 
in the body of the email. Your colleague will have no excus e to give 
regarding not seeing or acting on the data.  
 

 
 
 
So what if you needed to print it for your boss.  
 
Hereõs what you get from Print Preview. 
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So how can you make Excel print this table on just on paper?  
Very Easy. 
 
Go to Page Layout menu, and under the Scale to Fit section, set the 
Width and Height to 1 page.  
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So letõs see the result. 
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Goal achieved! But it could have looked better if it had used more 
space, the space below. So we need to try out one more setting and 
see if it will give us a better result. We will set the Orientation to 
Landscape. 
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Letõs view the result. 
 

 
 
Bravo! This is much better!  
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What if the boss wanted just January to May data and not the entire 
table? 
Also very easy.  
 
Highlight the table from the beginning up  to May, leaving out June. 
So we are highlighting just what we want to print.  
 
Under same Page Layout, Click on Print Area, and select Set Print 
Area. 
 

 
 
And thatõs it! So letõs see the result. 
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There we have it, no June data included!  
 
One more big tip .  
 
What if you have a big table that will print onto many pages but you 
want the header to repeat on the first row of every page?  
 
Below is a sample. 
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Notice that the page two has no header to help you identify what the 
fields are.  
 
So hereõs how to fix that.  
 
Still at Page Layout menu, click on the small icon at the bottom right 
corner of the Sheet Options section.  
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In the dialog box that comes up, set the Rows to repeat at top  
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Select Row 1 that has the headers.  
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And that is all!  
 
So letõs see the result. 
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Done. 
 
So these are the basic ways you format your data for printing.  
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Custom Lists 

If you are an average or above average Excel user, you will be very 
familiar with Excel autofill. A common example is you typing numbers 
1 and 2, then dragging to have Excel do to 10 for you. Or having 
January and February, then dragging to have Excel do the other 
months of the year for you.  

What if I tell you that you can create your own list. A list of states in 
Nigeria which you can autofill whe never you need to recreate them. 
Or a list of your products; you simply type the first two and drag to 
create the rest (autofill). It even helps you with sorting in the order 
you've created the list. This can be super useful for companies that 
use codes for aspects of their operations -- base station address code, 
branch code, product code and so on. Caution: The custom list has a 
quite limiting size limit.   

So here is the example of how I created a custom list of states in 
Nigeria, arranged alphabetical or der.  

First, I have the states typed out in Excel, in the order I want it 
(alphabetical order).  
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And we are half -way done to having it permanently in Excel as an 
autofill -able list.  

Go to File, Options, Advanced, and Edit Custom Lists.  
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In the Custom List Dialog box that comes up, import the list of states 
you already have typed into Excel.  



 

99 
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And you are done. 

Now in a new Excel file or Sheet, type in the first two states, select 
them and drag down. Excel will start autofilling the other sta tes.  
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Congrats! Now you've created a custom list. No more typing out 
states in Nigeria, just type the first (or first two) and have Excel 
autofill the rest for you.  
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Charts 

 
Excel 2010 has 11 main chart types. 
 

 
 
Excel 2013 and Excel 2016 have 10 main chart types. Actually, 9 If 
you take combo chart as a combination of two or more other chart 
types.  
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But in all you will end up using majorly,  

1. Column chart 

2. Line chart  

3. Pie chart, and  

4. Bar chart.  
 
So letõs focus on these four charts. 
 

Column Chart and w hen to use it.  

Column chart is used to visualize data across different categories. An 
example is revenue across the four different branches of a company.  
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So how do you turn a boring data like this:  
 

 
 
Into a beautiful insightful chart like this:  
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It is very easy.  
 
Select the table data you want to make a chart of and go to the 
Insert menu, click on the Column chart and select the 2D Clustered 
Column chart (the first option).  
 

 
 
You will get a chart that looks like the one below. Not bad looking, 
j ust needs a little formatting to make great.  
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Click on the chart, and the context based menus will show up on the 
Excel menu bar. 
 

 
 
 
Go to the Format menu and choose a formatting you like for the 
entire chart. If your companyõs corporate color is red and purple, you 
might want to make charts that reflect that brand color.  
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See the result red border white fill format.  
 

 
 
You can also change the chart background color.  
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Also you can change the color of the bars by clicking on them and 
choosing the color you want.  
 

 
 
And this is the final result.  
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It looks better than the default and reflects your companyõs 
corporate color. Just that you might want to not use the red border. 
Most professionals argue that itõs best to not use any border or 
background, just make only the important things obvious ð data bar 
and the axis label. I suggest you do whatever looks great to you. This 
is not an exam and most likely what will look good to you will look 
good to your colleagues whom youõll share the report and charts 
with.  
 
If you try out other color schemes you can end up with charts looking 
like the one below.  
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The extra step we took besides removing the red border and changing 
the bar color to bright blue is to change the chart area background to 
white.  
 

 




















































































































































































































